Project 1 — InDesign Tutorial Feedback
Anne Moore, Rebekah Crosson, Dorothy Knosby

An excellent start overall with project one. You have a well-illustrated tutorial with numbered steps and
a convincing project assessment. As you revise for your individual portfolios, here is what you need to
do:

Include the version number on the title page.

You have a good and useful introduction. You forecast what users will learn, the scope of the tutorial,
and describe audience for the tutorial. You’ve usefully included the approximate time needed to
complete the tutorial. Also, best if you forecast the typographic conventions you've used, like the use of
bold and quotation marks for menu items and for keystrokes to be entered.

Don’t give novice users choices/options unless you must. Be directive. Tell them what size,
approximately, to make the needed textbox on page 5, for example. Novices often feel they don’t know
enough to make wise choices so remove that worry whenever you can.

Define the purpose of each section and any key terms. For example, why are users inserting placeholder
text? The purpose is to visualize a layout and edit it before inserting the actual text and graphics, right?
So, define placeholder text and/or lorem ipsum for users who are tech comm students. Include a brief
overview or purpose statement for each major section of your tutorial. You do this wel for the Parent
Page section, for example. | suggest that you move away from the centered red text for these sub-
sections and instead consider something like flush left black text on a light-colored rectangular
background.

Make your own page layouts more consistent. You've used a magazine style with graphics that appear
right aligned in a two-column format, centered in a single column layout, and in one case, a full-page
graphic. Better to set up a multi-column layout with a consistent gutter between the columns as most
professional tutorials are setup. The gutter need not be centered. You can give one column to text and
one to graphics consistently. Size and crop the graphics to fit the column. Too many of your screen
captures are very large with very small areas of interest highlighted {p. 7, 11, 12, 13, and 14). The
alternative would be to go to a single-column layout but position the graphics below the text that
introduces them. You do this in places, but then align the graphic to the left and introduce a narrow
column beside it to the right, but not consistently. Please replace the poorer quality illustrations with
more deliberately sized and cropped versions.

Create visually distinct styles for menu items, for text entered into fields, and for any warnings or notes.
You could make more use of color to help users recognize each type of information quickly. | like very
much that you have included icons from your screen captures directly in your written instructions in
places as well as highlighting them in the accompanying graphics. | think you could do even more of this
effectively (see p. 5 & 6). Turn off hyphenation throughout.

You have a useful conclusion that lists what users should have learned and links to a troubleshooting
resource — other Adobe tutorials. | think you can live without pointing them to Google.

Tentative Grade: A
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Team members of Group 1 for Project 1 were Rebekah Crosson, Doroth Knosby, and

Anne Moore. The team members are all graduate students with extensive writing

experience and are professional teachers. Dorothy was new to InDesign although she

had excellent Photoshop skills. Rebekah had some previous InDesign experience. Anne

had recent InDesign experience since she had taken the Information Design and Digital
Publishing course in the fall. Dorothy and Rebekah quickly mastered the basics of

InDesign the very first week we were working on the project. Our task was to develop a

tutorial to teach novice InDesign users who are technical and professional writing W
students at UNC Charlotte. We outline the tasks we covered in our tutorial below.

Process

As Anne had the most experience with InDesign, she maintained the master InDesign
document. Dorothy was the Photoshop expert and edited some images that required
more manipulation than just cropping. We reviewed the various techniques for taking
screenshots from Windows devices. After the initial draft, we named and saved our
screenshots as high quality .pngs for maximum clarity. Rebekah was the text expert and
wrote major sections of the documents we worked on in class such as the Planning
Memo, Combined Analysis and Revision Plan, Usability Tests 1 and 2 Report, Usability
Test 3 Report, and Peer Review Report.

We divided up the tasks to be covered in our tutorial as follows and at each step we
were responsible for editing our own sections:

1. Anne Moore: Following the instructions, the participant will open Adobe™ InDesign®
2022 and create a new letter-sized document. They will name their completed file and
save it in Adobe™ [nDesign® 2022. ,

2. Anne Moore: The participants will create a textbox and fill it with placeholder text.

3. Dorothy Knosby: The participants will create a heading style in a specific typographic
style.



4. Dorothy Knosby: The participants will apply the new style to headings in the
document and name the new style.

5. Rebekah Crosson: The participants will create a paragraph style.

6. Rebekah Crosson: The participants will apply the paragraph style to the text in a
textbox.

7. Anne Moore: The participants will use the parent page function to apply page
numbers and a running header to the document.

We composed all of our memos and documents other than the tutorial itself in Google
Docs because that allowed us to work collaboratively on our writing tasks. We were all
heavy users of Google Docs and excellent writers, so the writing process went

smoothly. Once we finished a memo, we each downloaded it to our personal drive as a
Microsoft Word document and then as a pdf. Anne submitted the memos during class, P
but Rebekah and Dorothy also uploaded them to Canvas before the deadline.

We began writing the text for the InDesign tutorial in Microsoft Word. We quickly found
that we had to reformat it significantly once it was in a textbox in InDesign, so after the
initial copying and pasting, we performed most of the editing directly in the InDesign
document.

We agreed to use the terms “drop-down menu” for the options across the top of

InDesign, “toolbar” for the source of major tools on the left, and “panel” for all of the

other tabs or menus that appear when you select a tool from the “drop-down menu.” We
used imperative language throughout, except for in the notes and comments, which =N
were more informal.

Usability Test Mechanics

For the first two usability tests, we had Group 2 members use InDesign on one of our
laptops and scroll through the tutorial on another of our laptops. This approach proved

to be very challenging for the participant because they had to scroll through the

InDesign file and look back and forth to the open InDesign file on the other laptop to
perform the task. For the third usability test, we printed out the pdf of the tutorial and the
individual turned the pages while performing the tasks on one of our laptops that had a
pristine InDesign interface. Giving the participant a printed version of the tutorial while Z /
they worked on a laptop worked much better. When we asked the follow-up questions,

the participant had to flip back through the pages to locate problem areas, but they had

to scroll on-screen using the other method. Asking the participant to manage two
unfamiliar laptops at once was overwhelming. We found that InDesign remembers

where the panels are from last use and we had to learn to reset everything from where/,
we had it arranged when we were last editing the tutorial on our laptop in InDesign.



Key Suggestions from Usability Tests and Peer Review

The major comments on our tutorial related to: fuzzy images, image sizes, arrows
covering text, too much white space, inconsistent use of terminology, sentences that
were too long or too short, and color for the comments. We addressed these issues
gradually with major edits after the usability tests and then again after the peer review.

We learned from Usability Test #3 that it was confusing if we let the text span across the

page from left to right with the image below the text. We went through the tutorial after

the usability test and created two columns in most areas, so that the text would be on

the left and the image on the right. This technique made the flow from text to image //”’7/ ’
much easier to follow and eliminated large blocks of white space.

Challenges

All three of us use Windows PCs and laptops exclusively, so we had to prepare our

tutorial for Windows PC users. We could not incorporate alternate instructions for Mac/ .
users. We tried to make this limitation clear in our tutorial. /"""

The major challenge was that we had to pass the InDesign document back and forth
between us and that caused the links to the images to break. After the initial draft,
Rebekah realized that the question marks and link errors don't show in the pdf version
that is exported from InDesign, so we stopped worrying about the original location of the
images. We still had to pass the InDesign document back and forth and the only way it
worked was to email it as an attachment to the next person with a new file name. We
had to carefully plan who would work on it when. We learned that the easiest way to
organize the work in the middle of the project was for the individual to edit their pages
and send their revised InDesign file. Anne would move the revised pages into the
master InDesign file while deleting the previous versions of the pages. This approach
was acceptable until we had to edit the text for consistent writing style, develop
standard naming conventions for InDesign menus and terms, and check the entire
document for inconsistencies. Anne performed this task after the post-usability test v
corrections and again after the peer review.

Another challenge Anne ran into during the editing of her task on applying a Master
page is that Adobe suddenly changed the term “Master” to “Parent: between the
usability tests and the peer review. She had to replace the screenshots and edit the text

of the tutorial accordingly.
%“’ / M



Anocther challenge was that Anne preferred to use a graphic to label the steps while
Dorothy and Rebekah preferred to use arabic numbers next to the text instead. We
agreed to allow that discrepancy to stand as only the peer reviewer commented on it.

Goal Accomplishment

We took the assignments for this project seriously. Each of us learned many new skills

in InDesign. We also learned how to plan, write scripts for, conduct, interpret, and e
incorporate suggestions into tutorials as a result of usability tests. We also expanded

our writing and editing skills for user documents.

Teamwork

The team worked cohesively together throughout the project. We worked diligently
during each class session often starting at 5:15 p.m. and staying past 9 p.m. We worked
individually on the weeKends and the week nights before the next class meeting to
complete as many of the tasks that would be due on a given class night as possible, so
we could maximize the time together for group work. We were not able to meet
synchronously between classes because of work and class schedules. It was a highly
productive group. We are extremely satisfied with the resulting tutorial. Our strong work
ethic and excellent baseline skills enabled us to build our expertise and produce a
guality product.



ENGL5181
Project 1 Style Guide
Group 1: Anne Moore, Rebekah Crosson, Dorothy Knosby
March 2, 2022

Page Format - edit for consistency

Size-8.5"x 11"

Orientation (tall or wide) - Portrait

Margins - 0.5 on all 4 sides

Header - A running head on the right side in the margin in Georgia Size 12 “InDesign: Text,
Styles, and Page Numbering”

Footer is the Page numbering - Page # on lower right side in the margin in Georgia Size

Columns - One column 7.5” x 10”

Colors - the Headings and diamond borders around step #’s in certain sections are in Red
C=15 M=100 Y=100 K=0

Typography - edit for consistency
Document title - Tahoma Bold 24 pt white centered in a textbox with
C=15 M=100 Y=100 K=0 fill
Heading 1- Script MT Bold Regular 36 pt C=11 M=99 Y=96 K=2 left-justified
Heading 2 - Georgia Bold 14 pt C=15 M=100 Y=100 K=0 centered
captions for illustrations (font, face, size, case, placement, emphasis) - Use arrows to direct
eye to the illustrations from the text
Menu items, as represented in the text (icons, font, face, size, case, placement, emphasis)
Key strokes, as represented in the text (icons, font, face, size, case, placement, emphasis)
Spacing (leading & kerning- usually normal but may be compressed for copy-fitting)
Cautions/ warnings - Georgia Bold 14 pt C=15 M=100 Y=100 K=0 centered
Comments - Georgia Bold 14 pt C=100 M=0 Y=0 K=0 centered
Hints (font, face, size, case, placement, emphasis)
Steps - In our group of three, one person preferred to use an image for the step number
and the other two preferred text
Other list items (numbers, bullets, font, face, size, case, placement, emphasis)

Mechanics

Abbreviations to use after first reference - None

Acronyms to use after first reference - None

Capitalization - Capitalized InDesign terms and software names - Fill, Stroke, Save As, etc.
Hyphenation - Turned off.

In-text definitions - Added as notes.

Quotation marks - Smart quotes

Spelling - American- English



Usage

Imperative voice - Second person direct address of reader is optional - Used “you” when
imperative was not appropriate, to engage the reader, and make it more conversational and
informal in certain sections.

Gender references - Used “they” a few times, but “you” was the predominant term in order to remain
gender neutral.

Figures & Tables
Captions (include figure numbers & titles?)- No captions used. Instructions were written to
lead the participant to the figure (read: image) without the need of captions.

Consistent size, cropping, and placement- After three usability tests, it was agreed upon
that all three group members should attempt consistency by ensuring photographs
are large enough to be clear. All photographs were cropped enough to show the
necessary elements within the image that are relevant to the related textual steps. In
regard to placement, vertical photographs included vertical text, and were placed on
the right-side, whereas, horizontal images were centered and included horizontal
text. :

In-text references to figures & tables (font, face, size, case, placement, emphasis)- Bold font
was utilized to show specific text that references the figures (read: images). The bold
was implemented on the standard 14pt Georgia font style, [Black] C= 0 M= 0 Y=0 K=
100. The placement is within the text when needed. The bold font shows emphasis on
certain names and features that are considered important in the instructions.

Units of measure (inches, centimeters, picas, points, etc.})- The overall layout was formatted
by inches, with %2” margins around all pages. There were no specific units of
measure used within the instructions.

Decimals aligned vertically (decimal tab setting in a table of contents, for example)-
Decimals aligned vertically and left-justified to match the rest of the text.

Typography & punctuation of elements such as lists, headings, titles (none, final periods,
serial commas, font, case)- Since there are no captions, there is no specific
typography for figures & tables. However, the instructions were written with 14pt
Georgia font style, [Black] C=0 M=0 Y=0 K=100. There are some areas of text which
indicate importance and they use 14pt Georgia font style [Red] C=15 M=100 Y=100
K=0. There are some areas of text that show completion of a task and they use 14pt
Georgia font style [Cyan] C=100 M=0 Y=0 K=0. Heading titles for each section
consistently utilized 36 pt Script MT Bold font style, [Red] C=15 M= 100 Y=100 K=0.
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InDesign: Text, Styles, and Page Numbering

Introduction...

This tutorial is a step-by-step guide to a few basic tasks in Adobe™ InDesign®
2022 (InDesign). The audience is novice users who are technical and professional
writing students at UNC Charlotte. The tutorial is written for Windows PC users
and does not include instructions for use of InDesign on a Mac device.

The tutorial provides instructions on how to:

1) set up, name, and save an InDesign document;

2) create textboxes and fill them with placeholder text;

3) create a heading style in a specific typographic style;

4) apply the new heading style to headings in the document;

5) create a paragraph style;

6) apply the paragraph style to the text in a textbox; and

7) use the parent page function to apply page numbers and a running header.

The tutorial is simplified and customized to get students in UNC Charlotte
courses quickly into using InDesign for their coursework. The students in these
courses may have a wide range of experience with Adobe InDesign from no
previous experience to advanced professional experience. These students are
preparing for professional positions as technical writers, graphic designers, .
usability experts, and other related careers. pu Printio s 1o fre T 7

The tutorial is intended to be open next to a blank InDesign document and
followed step-by-step as the student works through the tasks. By the end of the
tutorial (which should take 25 minutes to complete), students will be able to
repeat the tasks independently and build their expertise with other tutorials that /#*7
focus on other basic InDesign tasks.
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InDesign: Text, Styles, and Page Numbering

Create an InDesign Document...

@ Download and install Adobe InDesign on your computer.

<2> Double-click the . desktop icon on your computer desktop, or, select i i
Q) 0

Creative Cloud @2 from your list of applications on your Windows El menu  +énw /
and open the latest version of InDesign from the list. Wait while the applicas)

tion loads. -
% o
. “ » ﬁfr‘”’f}r
o Double-click on “Letter. T By

A bt 5

Welcome to InDesign, Anne

B =

Letter iPad Pro Web 1920 More Presets

@ A blank letter-sized document
will open.

AN\ IE

>£
S|
[ &
=]
=]

P ode

o

L]
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InDesign: Text, Styles, and Page Numbering

@ File Edit Layout Type Object Table View Win
Click on the “File” drop-down menu and = ey ;
select “Save As.” Open... Ctrl+0
Browse in Bridge... Ctrl+Alt+0
Open Recent 4
Close Ctrl+W
Save Ctrl+S
Save As.., Ctrl+Shift+S
Check In...
Save a Copy... Ctrl+Alt+S
Revert
Search Adobe Stock..
Place... Ctrl+D
Place from CC Libraries...
Import XML...
Import PDF Comments...
Adobe PDF Presets >
Export... Ctrl+E
Share for Review...

Publish Online...
Publish Online Dashboard...

Document Presets d
Document Setup... Ctrl+Alt+P

Click on the folder where you wish to save your document. (“Desktop”).

@ Save As

« ~ 4 B > Anne Moore » Desktop L /= Search Desktop

Organize - New folder

@ OneDrive - Pers | Name Date madified Type Size

2 Anne Moore Na iterms match your search
cisco
3D Objects
« Contacts
o Creative Clou
M Desktop
“# Documents
¥ Downloads
% Dropbox (Pers:
2 Dropbox (UNC
e ENGL5181 S¢
o Diagosticw
o Project One ~

File name; |My InDesign Document 1

: InDesign 2021 document

Always Save Preview
Images with
Documents

~ Hide Folders Save Cancel

@ Type a Name for the file in the “File name:” field. Click the “Save” button.
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InDesign: Text, Styles, and Page Numbering

Cureate a Jeatbox with Fillenw Jeak...
+ OVERVIE ce?t, 75T WHy Do THS L

@ Click on the whitﬁzfj})n the vertical “Toolbar,”
\

€ T
M"”ZM; i

ETIRYV

@ Click in the document and hold
down the mouse button while
you drag down and to the right
to create a textbox ofany size.

25
A
2,
4,
B,
[,

7 ﬁ;ﬂpi
?ﬂ?f" ) /Cr)ﬂﬁhff‘ CIzE
uw A

textbox

<3> Right-click inside the textbox to bring up the fly out menu.
Left-click on Fill with Placeholder Text.
The textbox will be filled with Lorem Ipsum filler text.

Paste Ctrl+V
Font >
Size ’
Find/Change... Ctrl+F
Spelling > t\iiiiiéﬁ eum que ea volo odipisc itesto
Text Frame Options Ctrl+B searum ab intianda quis idiossi taturi

: cuptatem id elesti de por molut occus aciet

>

Anchored Object aborer iostore nusci aut istori tet harum
Change Case > aut estrume nihicillis ent, officae etum dit
Show Hidden Characters Ctrl+Alt+] et erro molorer ibusam ea verions equunt,

soluptas ipsam dit volecatiis etur, voluptaest
Juidis eiume nonsectur re, voluptiis expe
Insert Endnote nolupta tionectemqui officias min perupta
Insert Variable > tibusam is as aut enditium hil iunt lam as
fem con con planit dem dollaut aliquibus

Insert Footnote

Insert Special Character > o . L

; : et, odi adignatem solor auditias et faciaep
Insert White Space srchitemqui desed ea quiam, cuptatur?
Insert Break Character 2 Henimporum fugiasp elleseq uiatius,

vit

Taa Text >

borepuda imporporepta vellora erilatio|
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InDesign: Text, Styles, and Page Numbering

Creating a New HeadingStyle...

o e 1o R BE T

1. Create a new blank textbox at the fasne
top of the page (following steps 1 and 2 Ag thone]
under Create a Textbox above). In the A
new textbox, type in the word “Heading” i
and center it, using the center button TR
found in Properties panel under A sooie
Paragraph. Ll

2. Make sure you have the Character il o]taet

Styles panel selected in the :*H“ -
Properties panel. It is located next to the ke
Paragraph Styles panel.

Bullets and Numbznng

[ I=
L F

Ophians

Quick Actions

You will now change the font size of
the “Heading” text.

1. Highlight “Heading.” Next, look at the
Character section in the Properties
panel. The Character section is

the second section, underneath the T o IR
Appearance section. 1 v p

\

2. You will see an icon ooks like a Bt
little T and a big T: This is the icon for Vakdl .
font size. Use the drop-down arrow to e ? T 2
change the font size to 36pt. e ,ca/‘; ﬂ,m :
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Next, you will change the font

style.

1. While the text is highlighted,
click the drop-down arrow of
the first Character search bar.
This is the font search bar. The
default font style is Minion

Pro.

2. After clicking on the drop-down
arrow, move down the scroll bar
until you find Bell MT. Select it.

InDesign: Text, Styles, and Page Numbering

]\hl [TJ Cucunials »

Furde  Find Mure
e T ok (D
Bperey 111(2)
Myeiian
el (9}
arvd Revrded MU 1ialkd
Ihradheft (1)
Beshemile Ol Fuve
Bett s $3
Itell M1 {4
lteri Sers 11(7)
Eerin S FB Derni
EERH'RD

liernand M1 Candansedd

Proparties  Pager L€ Librarie
Toab Dreenion

Tod 5c

Farazrazh des

AT [4:0k]

A

LHICE T TH

A -

Subeuled Tesl
Sumpk;
SAMPLE
Sample
Sample
Sarnply
Suanple
fample
Sample
Sample

Page 7



InDesign: Text, Styles, and Page Numbering

Now that you have changed the font style, you will now change the
font to Bold/Italic.

1. Underneath the first search bar,
another search bar reads Regular.
Click on the down arrow and choose
Italic, Bold, or Bold Italic. In the
example below, Bold was selected
for the Bell MT font.

Properties Pages CC Libraries
Characters

Text Style

Paragraph Styles

Ag [Mone]

A.

Appearance

Ve -
Pl ceoke

Character
Q. Bell MT
Regular

v

Italic

Bold
11 . 1100%

Headingi

The text is in a new font style and in bold.
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InDesign: Text, Styles, and Page Numbering

The final step of this task will be to change the color. Remember to
keep the text highlighted.

1. Look at the Appearance section A - s
(above the Character section), A’ Reo A
which is where you can change /
the font color. Notice two white
squares that have a red line
running diagonally through each
one. One will be titled Fill and ongj
will be titled Stroke. In order to
add color to the text, use the Fill
option. Click on the square next to
Fill.

Appearance

' Fill
u Stroke

2. A smaller window appears that
shows a variety of colors to choose

from to apply to the text. For Rearance
this practice, select the red that W
has the C=15 M=100 Y=100... n ml m Tl
properties. This will change the i

Aoply To: | Text

color of the text. L e

Tink:

eqular
P [Nane]

¥ [ Clant v th 2 w2~

.r\ Metics v Ws! 3

[Registration]

W [raen

[Black] HE [ Clwooxe ~ T 7 100 |~
C=100M=0Y=0k=0 [ 4 2~ ot T o
c=0M=100v=0k=0 24

nglich: USA 5 :
B 0y tcks 4 nglish: US, OpenType

C=15M=100Y~100.. E M

C=75M=5y=100K-0 [ 4

Good work! You have now successfully changed the font size, style,
bold/italic, and color. Now that the changes have been made, you can
name your new typographic style.
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InDesign: Text, Styles, and Page Numbering

Naming New Fypegraphic Style... ,
Soupet® DY ~ Zasy 75 Crome #IA

SIS TRACSS  LOUTH mfa po—

You now know how to change your font in valﬁous ways. The next
step will be to name this new typographic style.'Make sure that your
Lt" “Heading” text is highlighted. You will also want to double check that
you are still in the Character Styles tab in the Properties menu on the

right. This is particularly important in naming your new style.

Vﬂ 1‘.,4”‘

1. In the Character Styles panel, you will see an A. icon like this.CIick on the
A.icon. A list of options will appear. Click on the first option named Character
Styles.

2. A new, smaller window will appear. Look down at the bottom panel of this

new window for a small icon that is a square with a plus sign. This is the
Create New Styles icon. Click on it.

o T Cond i P e di U i Fs= T e elis ekl aiin Vg radiea, caed o, i
200 o s esliss e sndodin, guas Al dekna

las v ipdiers oy ge terd wrs pablans peoieo, nam dlicon vy eridsad haoua L [vica e 1am ois
wiraaigiads el fi b Seviear drobas 7 e 00 0 esrriedes pabli winporsnmm Jical em.
aiblipiaim dabecit g Blor ks, 1 P viven sl saigss o, qied coreinis divedd ine oomudices con-
Fial gl pd Tl e cuiminais coaailagies <o, hores® Vile dikids iy xlnu-\lim i Nm v ﬂ:nhcd

Feriel berind iendd issend, i poper gon disanatises. 4 iw TR AT T A
et ere Gibdividin. f4r X st 4< inbe 1am Gt milks nides o
ISR LT BN TN TGS T ERGTA R AV TR ITATR T TG SN T § Chara<ter Styles Paragraph Sty
gz beanim Bihdne Banssiim egerohad vioriem P Habeon insfgpsm ad s
M sl prosaliem qal intiaa gie sucer v reomade tham o re o0 d @ISR
o wignsce dean pobbn pearion pabdis det cvieone o
wrsTi AN Of AT 10n B Fabeniod wedrver vt idin qaanm i ] [Neia)
Mhans by dosii ommdet i@licd iBniesd g eangplas o ardd SIEiAR (GO LT ¢
cor, o Fins vis i ils, peser e, Qe cinon hll frskid e eetiebanips ik
“}ﬂ’l i ef ponticrimrbee g e s hil biligoi prie

Lacnkooris Am iy staladimeaod contickanit Habe sgeris oo Sid v
s by s s Mdor o priacinequn o s vinndio adam e,
Fagaickan pencia? Norain boatred gross e Wk ) i fan srike o o
aal ek Aume it cre offnebss odeciciead, o sl inabgisn im ¢ oo o
(eAbard Ml i, Do anin be g bigiont Edefonanninl Hes et po

Page 10



InDesign: Text, Styles, and Page Numbering

3. A new name will show up in the list, Character Style 1. Double-click
Character Style 1 and a new window will open.

4. Replace the name Character Style 1 with a new name for the typographic
style.

[G"wamcr Style Options

Gértiral
W ﬂ ? s Baysic Charschar Formabs
ﬂd‘) AR General
'3 i

shiics
Urdesine Ophions
Sriketheagh Dotars i
Exauit Tajum { Hesst To Base |

[Mare] + Bzl WT + siee; 35 pt + colon £=13 M=100 Y=100 K=0

L) Preview

WARNING: Before you rename, check that the properties you
applied to the new font type have remained the same. Otherwise, all
of your hard work won’t be saved!

5. In order to check this, look at the left panel and find the names Basic
Character Formats and Character Color. Click on each option on the
menu, starting with Basic Character Formats. Verify the selections for
size, font style, and bold/italic.
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InDesign: Text, Styles, and Page Numbering

6. If everything is correct, clichen, rename the font type in the
Style Name bar. In the example, the new style is named with the default

Character Styles 1. FamaT for Thse ?

7. Once you rename the new typographic style, clic save and then close
the Character Styles panel. Notice that the newfont type is visible in the
Properties panel under the Character Styles panel.

Meader

| E e
| e e e
| B b d g ey

| [+ o opa M bsminti byt o e i b ptian
™

Congratulations! You have now learned how to make a new
typographic style and name it! Now you can move on to the next
step!
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InDesign: Text, Styles, and Page Numbering

Creating a Saragraph Style
pVeRVIEY 17 /JH‘}’ Do FHS

1. Select and highlight the text. Open the Paragraph Styles panel on the right
side and select New Paragraph Style.
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2. The Paragraph Style window will appear with a default name
highlighted. Enter a new name. Click or@at the bottom-right of the

window.,
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InDesign: Text, Styles, and Page Numbering

Upplying a Faragraph Style

1.Apply the style to any paragraph. Highlight the text and then click on the name
of the style you saved in the Paragraph Styles panel.
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InDesign: Text, Styles, and Page Numbering

Create a Sarent Sage...

ﬁ"* {”"P ?W A Parent (or Master) Page is a nonprinting page that serves as

f a template that can be applied to some or all of the pages in your

g{" document. Parent pages contain text and graphic elements like page

.Jrl‘ - numbers, headers, footers, etc. that you want on all or most pages.

W You can have as many parent pages as you want in a document and
apply them to individual or groups of pages.

qﬂ
u"”@,ﬂ“‘
On the upper right side of Sur B
the InDesign document G
screen, click on the Pages pancl. o
If the Pages panel is not showing, [Slss B 521 PIoReIce
click on the Window drop-down illi Pages
menu and click on Pages. L e [ cc Libraries

: Double-click on A-Parent in the
Pages panel to display the Parent
Page.

ddd Autematic Page Numbexns...

<1> With the A-Parent still highlighted, create a textbox large enough to hold
the longest page number and any text you want to appear with it. Position
the textbox where you want the page number to appear, normally in the

lower-right margin of the document. \ |

<2> In the page number textbox, add any text that will come before or after the
page number (such as “Page ”) and format it using the Paragraph Style
set up previously.

@ Position the insertion point the page number should appear, and from the
Type drop-down menu select Insert Special Character > Markers >
Current Page Number. See image below.
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InDesign: Text, Styles, and Page Numbering

Object Table Window

Type View Help

Font 4

Size > § s
v| Character Ctrl+T .

Paragraph Ctri+Alt+T

Tabs Ctrl+Shift+T

Glyphs Alt+Shift+F11

Story

Character Styles Shift+F11.

Paragraph Styles F11

Create Qutlines Ctrl+Shift+0

Find/Replace Font...

Change Case >
Type on a Path >
Notes ?
Track Changes >

Insert Footnote
Document Footnote Options..,
" Insert Endnote
Document Endnote Options...
Convert Footnotes and Endnotes...

Hyperlinks & Cross-References ?
Text Variables g

Bulleted & Numbered Lists y

Insert White Space ? larkers
Insert Break Character 2 Hyphens and Dashes
Fill with Placeholder Text Quotation Marks

Show Hidden Characters Ctrl+Alt+| Other

¢ Character
Q. Georgia

Bold

T 412 (aap

VA

*Arrows Bullets Headings Numbering.indd @ 88%

a

8
5

llﬁDEigﬁ ‘Tips and Tricks

urrent Page Nu
Next Page Number
Previous Page Number
Section Marker
Footnote Number

Page
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InDesign: Text, Styles, and Page Numbering

Udd a Running Fead...

@ With the A-Parent still highlighted, create a textbox large enough to hold
all the text of the running head in the desired location, usually above the
frame of the document in the margin and aligned right.

C Type the text to appear at the top of every page. Format it using the
Paragraph Style set up previously.

Upply the Farent te your Sages...

@ Right-click on a page to which
you want to apply the Parent
Page in the Pages panel.

Select Apply Parent to
Pages. Apply the Parent Page
to any or all pages.

Essentials

§1 Propertie: ¢ Pages CC Librari =
=2 Properties

None
L) . ﬂh Pages

A-Parent .
U¥ cC Libraries

Insert Pages...
Move Pages...
Duplicate Spread

Print Spread.

Override All Parent Page Items ~ Ctrl+Alt+Shift+L

Create Alternate Layout...
Numbering & Section Options...
~!| Allow Document Pages to Shuffle
'+ Allow Selected Spread to Shuffle
Page Attributes >

View Pages >
Panel Options...

Congratulations! You have now learned how to add page numbers,
a running head, and a parent to your InDesign document!
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In this tutorial for novice technical writing students, you learned how to perform
the following tasks in Adobe™ InDesign® 2022 on a Windows PC or laptop

device:

1) set up, name, and save an InDesign document;

2) create textboxes and fill them with placeholder text;

3) create a heading style in a specific typographic style;

4) apply the new heading style to headings in the document;

5) create a paragraph style;

6) apply the paragraph style to the text in a textbox; and

7) use the parent page function to apply page numbers and a running header.

If you need additional information on how to use InDesign, visit the Adobe
InDesign User Guide, which is continuously updated.[ff you cannot figure out
how to perform a specific task, search on Google or another search engine to find

ri fvi . 7
a variety of videos i

You have successfully completed this tutorial!
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